
 
 

 

23399 Commerce Drive, Suite B-5A 
Farmington Hills, Michigan 48335 

www.optivasystems.com 

Phone (248) 471-6100 
Fax (248) 471-6101 

info@optivasystems.com 

 

P l u g - i n  D o w n l o a d s  f o r  S p i n F i r e  P r o f e s s i o n a l  8 . 3  and later Only Page 1 of 15 

Plug-in Downloads for SpinFire Professional 8.3 and later Only 

Current customers of SpinFire Professional 8.3 and later can download Actify created 
plug-ins that can enhance and add new functionality to SpinFire Professional 8.3.  You 
can download from www.actify.com > “Customer Login” page. 

 Model Compare Plug-in: Visually compare two models and display the material that has 
been added or removed (Model Compare Release Notes) 

 STL Export Plug-in: Easily export CAD files as STL files for use in other applications 
 DesignSharePlug-in: The DesignShare Plug-In allows SpinFire Professional to open files 

stored on a Windows SharePoint Services server. This plug-in is especially useful for 
organizations that use Actify DesignShare (which runs on a SharePoint server).  

 CADDS Plug-in: Some customers have systems that create or manage CADDS files that 
don't have a file extension. This plug-in allows a user to open these files without having 
to modify the name of the file 

 Cross-Section Plus Plug-in: The Cross Section Plus plug-in allows users to calculate the 
surface area and length of the perimeter for a collection of cross sections. The plug-in 
works with the cross section plane. 

 Automatic Part ID Plug-in: To increase productivity and reduce introduction of errors the 
Automatic Part ID plug-in was developed to add part information markup to each part in 
the assembly. For example if a user wants to add the part name to each part in the 
assembly today they have to type in the name manually. This is prone to typographical 
errors and is very time consuming. The Automatic Part ID plug-in automates this 
process.  

 Automatic Part List Plug-in:The Automatic Part List plug-in provides uers an easy and 
quick method for listing all the subassemblies and parts that make an assembly. 

 **Draft Angle Analysis Plug-in: The Draft Angle Analysis Plug-in allows the user to 
specify one or more parts in an assembly, and ask for visual feedback on what level of 
draft angle has been applied to these surfaces when compared to a "pull direction".  

**Note: The Draft Angle Analysis Plug-in is the only Actify Plug-in that is NOT free. If 
you would like to know more about this plug-in or if you would like to purchase it, please 
contact your local Actify Reseller or send an email to info@optivasystems.com.  

 

 

 

 

http://www.actify.com/
mailto:info@optivasystems.com?subject=Actify%20SpinFire%20DAA%20Information%20Request
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Model Compare Plug-In Build 1331 Release Notes 
August 7, 2009 

Description 

The Model Compare Plug-In compares two sets of parts or assemblies and displays the material 
that has been added or removed. 

By default the added material will be shown in blue and the removed material will be shown in 
red, but users may change the colors of the added and removed material. 

Requirements 

• SpinFire Professional 8.3 Build 1212 or later 

• Reader Build 1247 

• .NET 2.0 

Improvements/Bug Fixes 

The only issues addressed in this release fixes a problem with compatibility with other plug-ins.  
Plug-ins were developed with different versions of .NET and when SFP is launched, not all plug-
ins would activate if other plug-ins were installed.  With this build the incompatibility issue has 
been resolved. 

Known Issues 

Visual Comparison Only—The Model Compare Plug-In produces a graphical effect that can be 
used to visually compare two models. Because part transition tolerances can affect precision, this 
should not be used to provide an exact volume comparison but should be used only for a visual 
comparison of two models. 

Previous versions—Any previous version of this plug-in must be uninstalled before this version 
can be installed. 

Location on SpinFire Pro Interface 

• Edit Menu Toolbar: The edit menu toolbar has a new Compare Model option which brings up 
the dialog. 
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Procedures 

To Compare Two Models 

1. Invoke the Model Compare Dialog from the edit menu on the toolbar. 

2. The model compare dialog gives the user options to select the parts/assemblies  

into each of the two compare sets. 

3. After the selection of parts/assemblies for the two sets, the user could compare  

the two models for the “Added” material by clicking on Compare Sets. 

4. The user could choose to display either the added material or the removed  

material by selecting/deselecting the Display Removed material in the Material  

Options section. 

5. There is an additional option to invert compare which inverts the comparison of  

one set over the other (compare set #1 over #2, or inverting would compare compare 

set# 2 over #1) by simply clicking on the Invert Compare button. 

6. After the comparison is completed the user could choose to save the view by  

clicking on Finish which displays the view save menu where the user could enter the 

desired view name. 

7. To cancel the model comparison at any point of comparison the user could click  

on Close. 
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To Change the Default Color of the Added, Removed, or Unchanged Material 

1. While the Model Compare dialog is open, click the Added, Removed, or Unchanged 
button and this opens the Color dialog box. 

2. Choose a color and click OK. 
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STL Exporter Build 1331 Release Notes 
August 7, 2009 

Description 
 

The STL Exporter creates STL files as part of the publishing conversion process. 

 

The STL file that is exported will contain a single part and a single surface, regardless of 

the number of parts and surfaces in the original design. 

Requirements 

• SpinFire Professional 8.3 or above 

• Reader Build 1247 

• .Net 2.0 

 

Improvements/Bug Fixes 

The only issued addressed in this release fixes a problem with compatibility with other plug-ins.  
Plug-ins were developed with different versions of .NET and when SFP is launched, not all plug-
ins would activate if other plug-ins were installed.  With this build the incompatibility issue has 
been resolved. 

 

Location on SpinFire Pro Interface 

• Menu bar: Under the File menu, the Export submenu contains the STL… command. 

 

Procedures 

To Save the Active 3D Document as an STL File 

1. On the menu bar, click File. 

2. Point to Export. 

This opens the Open File dialog box. 

3. Click STL… 

This opens the Save As dialog box. 
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DesignShare (WSS) Plug-In Build 1331 Release Notes 
August 7, 2009 

Description 
 

The WSS Plug-In allows SpinFire Professional to open files stored on a Windows 

SharePoint Services server. This plug-in is especially useful for organizations that use 

Actify DesignShare (which runs on a SharePoint server). 

 

If the file is located on a server running Actify DesignShare, then users can also check 

out a file and check in changes made to the file back to the ADS server. 

Requirements 

• SpinFire Professional 8.3 or later. 

• Reader Build 1247 

• .Net 2.0 

Improvements/Bug Fixes 

The only issued addressed in this release fixes a problem with compatibility with other plug-ins.  
Plug-ins were developed with different versions of .NET and when SFP is launched, not all plug-
ins would activate if other plug-ins were installed.  With this build the incompatibility issue has 
been resolved. 

 

Location on SpinFire Pro Interface 
 

• Menu bar: The File menu contains the SharePoint submenu. 

• Toolbar: Contains the SharePoint menu. 

Procedures 

 

To Open a .3D File located in a DesignShare Document library 

1. Select the “DesignShare” tab located on the Components Tab on the left 

2. Select the  “Manage SharePoint Connections” icon  
3. Select the “Add” button 
4. Key in the following information (Substitute as needed) 
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 URL:                   http://designshare2.actify.com/demohub/ 

 Domain:              designshare2.actify.com 

 User Name:        your user name   

 Password:          your password 
5. If the connection is correct you will see the site listed on the left pane. 
6. Expand the site to see the sub-sites and Document Libraries available 
7. Select the Document Library to see the available files 
8. Right Click on a file and select the desired action 

 
9. When you are done working on the file you have the following options, depending on how the file 

was opened, by selecting the SharePoint Icon in SpinFire; 

 

File Opened                                                                    File Checked Out 

  

 

 

 

 

 

If you are checking the file back in you will also have the ability to add any comments; 

 

 

 

 

 

 

 

 

The file in the DesignShare library has now been updated with this latest version, and the SharePoint 
versioning has been adhered to. 

http://designshare2.actify.com/demohub/
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CADDS Plug-In Build 1331 Release Notes 
August 7, 2009 

Description 
 

Some customers have systems that create or manage CADDS files that don’t have a file 

extension.  This plug-in allows a user to open these files without having to modify the 

name of the file. 

 

Requirements 

• SpinFire Professional 8.3 or above 

• Reader Build 1247 

• .Net 2.0 

Improvements/Bug Fixes 

 

The only issued addressed in this release fixes a problem with compatibility with other plug-ins.  
Plug-ins were developed with different versions of .NET and when SFP is launched, not all plug-
ins would activate if other plug-ins were installed.  With this build the incompatibility issue has 
been resolved. 

 

Procedures 

 

File + CADDS Open … 

This opens a file dialog that allows users to select these files. 
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Cross-section Plus Plug-In Build 1331 Release Notes 
August 7, 2009 

Description 
The Cross Section Plus plug-in allows users to calculate the surface area and length of 

the perimeter for a collection of cross sections.  The plug-in works in conjunction with the 

cross section plane. 

Requirements 

• SpinFire Professional 8.3 or above 

• Reader Build 1247 

• .Net 2.0 

Known Issues 

The cross section analysis is very sensitive to good tessellations.  If there are gaps, then the 
algorithm cannot determine a closed path and the component is excluded from the analysis. 

Procedures 

To Analyze Cross Sections 

8. Invoke the XPlus! from the Applications toolbar. 

Note: The cross section must be on to enable the plug-in. 

9. The Automatic Part ID Markup dialog gives the user options to select the 
parts/assemblies and create the markup 

 

10. Select which components to include in the analysis. 
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Automatic Part ID Plug-in Build 1331 Release Notes 
August 7, 2009 

Description 
To increase productivity and reduce introduction of errors the Automatic Part ID plug-in 

was developed to add part information markup to each part in the assembly.  For 

example if a user wants to add the part name to each part in the assembly today they 

have to type in the name manually.  This is prone to typographical errors and is very 

time consuming. 

The Automatic Part ID plug-in automates this process. 

Requirements 

• SpinFire Professional 8.3 or above 

• Reader Build 1247 

• .Net 2.0 

 

 

Procedures 

To Create Markup 

11. Invoke the Auto Note from the Tools menu on the toolbar. 

12. The Automatic Part ID Markup dialog gives the user options to select the 
parts/assemblies and create the markup 
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After the creation of the markup the assembly would look something like the following. 

 

For more detailed information, the plug-in comes with complete on-line documentation.  

To access it select the question mark icon in the upper right corner of the plug-in dialog. 
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Automatic Part List Plug-In Build 1331 Release Notes 
August 7, 2009 

Description 
The Automatic Part List plug-in provides users an easy and quick method for listing all 

the subassemblies and parts that make an assembly. 

Requirements 

• SpinFire Professional 8.3 or above 

• Reader Build 1247 

• .Net 2.0 

 

 

Procedures 

To Create Parts LIst 

13. Invoke Parts Lists from the Files + Export menu on the toolbar. 

14. The Parts List dialog gives the user options to select the layout of the list and write the 
information to a text file for incorporation into another document. 
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For more detailed information, the plug-in comes with complete on-line documentation.  

To access it select the information icon from the plug-in dialog. 
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Draft Angle Analysis Plug-In Build 1331 Release Notes 
August 7, 2009 

 

Description 

The Draft Angle Analysis Plug-in allows the user to specify one or more parts in an assembly, and 
ask for visual feedback on what level of draft angle has been applied to these surfaces when 
compared to a “pull direction”.  

Requirements 

 SpinFire 8.3 Build 1212 released in March 2008 or later.  

 Reader Build 1247 

 .Net 2.0 

 Windows XP 

Functionality 
 

This release of the Draft Angle Analysis (DAA) plug-in represents a major upgrade from the first 

release.  Here are a few of the many items that have been included. 

 Licensing was added. 

 The display now uses smooth shading instead of flat. 

 The UI has been simplified to allow for either limit or delta tolerancing. 

 The analysis can be applied to entire parts or set of surfaces. 

 On-line help was developed and can be accessed from the plug-in. 

Improvements/Bug Fixes 

A problem with compatibility with other plug-ins has been resolved.  Plug-ins were developed with 
different versions of .NET and when SFP is launched, not all plug-ins would activate if other plug-
ins were installed.  With this build the incompatibility issue has been resolved. 

 

Additionally the following bugs have been resolved. 

6812 Dialog stays in picking mode when create coordinate system dialog is displayed 

6809 Analyze button should be enabled as long as the entity count is not zero 

6801 Switching to a different document before analysis is complete will cause DAA to hang 

6770 Entity count reported is incorrect when Shift-Select is used 

6769 Incorrect icon used for polylines in the DAA tree 

6768 Pick in Viewer stops working 

6767 Stop button doesn't work 



 
 

 

23399 Commerce Drive, Suite B-5A 
Farmington Hills, Michigan 48335 

www.optivasystems.com 

Phone (248) 471-6100 
Fax (248) 471-6101 

info@optivasystems.com 

 

D r a f t  A n g l e  A n a l y s i s  P l u g - I n  B u i l d  1 3 3 1  Release Notes Page 15 of 15 

6724 The default selection mode should be All Parts 

6723 Analyze button should be disabled when nothing is selected 

6610 Draft Angle Analysis plug-in should not do auto expand 

6609 Draft Angle Analyis plug-in dialog should come out of picking mode when user does a 
SFP action 

6606 Draft Angle Analysis plug-in's Stop button needs to be pressed twice 

6605 Draft Angle Analysis plug-in does not activate when first document is 2D 

6604 Draft Angle Analysis plug-in should switch to loading the new assembly when switching 
documents 

6603 Parts with no surface should be ignored by the Draft Angle Analysis plug-in 

6601 Need to change some text on the Draft Angle Analysis dialog 

6591 Uninstalling plug-in courrupts SFP install 

6562 Plug-in is not uninstalled completely 

5978 Licensing capability for authorized DAA module distribution 

5976 The DAA plugin needs to allow for upper and lower angle setting 

5975 Keep DAA window on top of SFP by default 

5550 Draft Angle Analysis plug-in dialog needs to close when user Adds documents 

5544 Draft Angle Analysis plug-in fails to pick after changing Reference Frame before picking 

5543 Parts no longer highlight after using Draft Angle Analysis plug-in 

5542 Draft Angle Analysis plug-in's version number does not show up on the Plug-in page on 
SFP 

5469 Draft Angle Analysis plug-in picking cursor canceled when going from 2D to 3D view 
mode 

5458 Draft Angle Analysis plug-in breaks Zoom Window drag box 

5452 Draft Angle Analysis plug-in will not work when installed into a different root directory 

Known Issues 

The following known issues exist with the Draft Angle Analysis plug-in.  

 Some parts have the surface normal incorrectly oriented (the surface normal points into 
the part instead of out) so the resulting analysis will be off. 

 

 

 


